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1. Background  
 
Monitoring of lung function in at-risk populations enables the identification of 
individuals with excessive decline of lung function. The spirometry test of forced 
expiratory volume in one second (FEV1) is the measure best suited for monitoring 
changes in lung function over time. The method of longitudinal FEV1 evaluation should 
identify those with an excessive FEV1 decline as early and accurately as possible.  An 
excessive decline in lung function over several years can indicate development of lung 
disease and has been shown to be associated with increased respiratory morbidity, loss of 
productivity at an earlier age, and increased mortality.1-3 
 
To ensure that individuals with excessive decline in lung function can be identified early 
and accurately, it is important to maintain precision of the longitudinal spirometry data.  
Statistical monitoring of longitudinal data precision, in addition to good quality control 
for individual spirometry tests, helps to maintain data precision at an acceptable level and 
provides the basis on which to determine an appropriate limit of longitudinal decline.4-6 

 
The Spirometry Longitudinal Data Analysis software (SPIROLA) is an integrated visual 
and quantitative tool for the detection of excessive lung function decline in individuals 
participating in spirometry monitoring. SPIROLA may help to preserve lung function 
through early identification of excessive decline followed by appropriate intervention.  
SPIROLA provides the following functions: 
 
For an individual: 
• It monitors the level of FEV1 and FVC in relation to criteria for assessment of cross-

sectional data: the lower limit of normal (LLN) and 60% of predicted. 
• It monitors FEV1 change over time in relation to criteria for assessment of 

longitudinal data: the limits of longitudinal decline (LLD). 
• It provides interpretation of the rate of FEV1 decline and its variability in an 

individual’s summary report and suggests actions to prevent further excessive loss.  
 
For a group of individuals: 
• It monitors longitudinal data precision using the pair-wise estimate of within person 

standard deviations sp (absolute) or sr (relative) (Section 5);4-6  
• It monitors spirometry quality control grades as provided by a spirometry system. 

These are expressed as a percentage of tests that do not meet the 2005 ATS/ERS 
criteria for acceptability and repeatability. The evaluation can be done by a technician 
code to determine whether additional training is needed for a technician.   

• It monitors means for observed, predicted, and percent predicted FEV1 and FVC to 
enable the user to identify systematic changes taking place at a group level. 

• It screens for individuals whose most recent lung function tests fall below the LLN 
and whose rate of lung function decline is excessive. 
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2. SPIROLA Installation 
 
SPIROLA runs on PC with Microsoft Windows system. For detailed software 
requirements see Appendix. 
  
1. Open NIOSH SPIROLA webpage http://www.cdc.gov/niosh/topics/spirometry/spirola.html. 
2. Click Software Download to download SPIROLA.  
3. Click Run button on the File Download window to start setup procedure. (If a 

warning "Publisher could not be verified" appears, click Run button to continue the 
installation.) If Run does not work, click Save on the File Download and follow the 
instructions to save the setup file on the local C: drive (for example: C:\SpirolaSetup) 
and then run on the local drive.  

4. Follow instructions specified by the installation procedure. User needs to read and 
agree with a DISCLAIMER to install and use the software.  

5. The Select Installation Folder window will appear, as shown below.  By default, 
SPIROLA is installed into C:\SPIROLA folder.  The user can override this default 
setting by designating an alternative location.  Click Next> to proceed. 

 

  
 

6. Follow the setup wizard instructions to complete the installation.  On completion, an 
Installation Complete window will display message “SPIROLA has been 
successfully installed.”  Click Close to exit. 

7. SPIROLA item will be added to the All Programs menu on the Windows Start 
menu, and a SPIROLA icon will be created on the Desktop.  

http://www.cdc.gov/niosh/topics/spirometry/spirola.html
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3. Operating Instructions 

3.1 Start and Close SPIROLA  
To run SPIROLA, double click the SPIROLA icon from the Desktop, or click the 
SPIROLA program via Start > All Programs > SPIROLA. 

 
A SPIROLA start screen will appear, as shown below.  To close SPIROLA, on the File 
menu click Exit, or just click the close button in the right upper corner of the window.   
 

 
 

3.2 Open Dataset 
The first step is to open a SPIROLA dataset which is to be processed. For demonstration 
purposes the SPIROLA package includes a dataset (C:/SPIROLA/DemoDataSet.mdb).  
See Appendix on how to create user’s own database in a correct format.  
 
1. On the File menu click Open.  A window will appear, as shown below. 
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2. Click on the desired .mdb file (for example, SPIROLA.mdb).  If the dataset file is not 
in the current folder, click on the Look in list, and then double click the drive and 
folder that contains the .mdb database file.  Click Open to proceed. For back-up, it is 
recommended that users keep copies of all SPIROLA .mdb files in a different folder 
(e.g., C:\SPIROLADATA). 

3. Click on a desired data table listed under Select a Table from Current Database as 
shown below and then click OK to load the whole dataset into SPIROLA. 

Note:  

To select a sub-dataset that contains only individuals whose last test is within a specified 
period, click on Last Test and select the appropriate period. SPIROLA will process the 
sub-dataset only during the current session. 

To automatically load the whole dataset next time, check the Load this Database and 
Table automatically next time.  
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3.3 Individual Evaluation Menu 
The Individual Evaluation menu lists functions for evaluation of individual FEV1 and 
FVC values, and percent predicted values (FEV1, FVC) and the FEV1/FVC ratio. Dual 
window feature shows the FEV1, and percent predicted values and the ratio on one chart. 
The summary report provides results of the analysis. Individual identity specification 
helps to identify an individual by name. 
  

 

Monitor FEV1 in an individual  

1. On the Individual Evaluation menu click Individual FEV1 Evaluation to show a 
chart for the first individual.  

2. Click the arrow next to combo box (ID box) on the left bottom corner and a part of 
the ID list will be shown (see below).  

3. Click up or down arrows or drag the scrollbar next to the ID list and click on an 
individual’s ID.  Alternatively, click on a starting ID and use the up and down arrows 
on the keyboard to display individual IDs or type the ID into the ID box.  

 

 

Regression line 
LLD ACOEMLLN 

60% predicted  
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The individual FEV1 chart shows: the observed FEV1 values (green dots) plotted against 
age; the linear regression (green) line fitted to the observed FEV1 data (when at least 4 
years of follow-up data are available); cross-sectional lower limit of normal (LLN) 
(purple) and 60% predicted (red) based on Hankinson et al. equations.7 (see Section 5).  
The blue solid line represents the limit of longitudinal decline (LLDr) calculated from the 
baseline observation(s) based on the default relative within-person variation of 4% and 
reference slope of 40 mL/yr (see Section 5-theory and Section 3.7-changing default).  
This LLDr is used to identify excessive declines up to 8 years of follow-up. Observations 
that fall below LLD should be evaluated as to whether the decline represents data quality 
issue or true decline. The turquoise (greenish-blue) dashed line represents the American 
College of Occupational and Environmental Medicine (ACOEM) longitudinal limit of 
decline calculated as LLD=Baseline FEV1×0.85- years×30 mL/yr.8  
 
Beginning with 4 years of follow-up, SPIROLA also tracks changes in the rate of FEV1 
decline and displays this against the scale on the right axis of the figure, as shown below.  
The brown dots show the running change in the rate of decline up to each data point and 
enable the user to discern the change in rate due to the last data point.  The yellow dots 
show the running change in the slope for the previous 8 years and enable the user to 
discern changes in the rate of decline in the last 8 years.  The three parallel lines represent 
30, 60, and 90 mL/yr rates of decline.3  The bottom margin displays the linear Regression 
Slope  and within-person variation Sw for the individual who has 4 or more years of 
follow-up and  Group Slope and Group Sw calculated as the mean of regression slopes 
and within-person variations for all individuals in the group. 
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Beginning with 8 years of follow-up, SPIROLA’s decision-making is based on the 
estimated regression slope and the projected age when the regression (dashed green) line 
crosses the 60% predicted line (solid red line).  The blue dashed line shows the 
longitudinal lower 95% confidence limit for the fitted regression line, estimated from 8 
years of follow-up data.  This limit can be used to test whether the last observation 
deviates significantly from the regression line predicted using all observations (see 
Sections 4 and 5). 
 
The table below the chart shows the individual’s demographic and lung function data and 
calculated rates of decline (Rate) at each test date.  Other data, for example name, weight, 
smoking status, cigarettes per day, quality control data, and a technician’s code will be 
shown also if included in the database. The bottom margin shows the individual and the 
group mean linear regression slopes and the absolute within-person FEV1 variation for 
the individual.  If desired, one or more outliers can be removed from the analysis by right 
clicking on it (see “Remove outliers from a longitudinal analysis” below).  
 
4. On the Evaluation menu, click Summary Report to view summary results of an 

individual’s lung function evaluation and a suggested course of action (see Section 4) 
as shown below.  Click OK to close the window. Click Print to print the chart and 
evaluation in one report. (See Section 3.6: Report Menu for details.) 
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Monitor FVC in an individual  

1. On the Individual Evaluation menu click Individual FVC Evaluation to show a 
FVC chart.  

2. Click the arrow next to combo box (ID box) on the left bottom corner to select the ID.  
See Monitor FEV1 in an individual for details on ID selection.   

 

 
  
The individual FVC chart shows: the observed FVC values (green dots) plotted against 
age; the linear regression (green) line fitted to the observed FVC data (when at least 4 
years of follow-up data are available); cross-sectional lower limit of normal (LLN) 
(purple, if specified to display) or 70% predicted (purple) and 60% predicted (red) based 
on Hankinson et al. equations.7 Observations that fall below the cross-sectional limits 
should be evaluated as to whether the decline represents data quality issue or true decline.    

70% predicted 
LLN 

Regression line 

60% predicted 
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Monitor percent predicted values in an individual 

1. On the Individual Evaluation menu click Individual Percent Predicted to obtain a 
chart with percent predicted values for an individual person, as shown below. 

2. Click the arrow next to combo box (ID box) on the left bottom corner to select the ID.  
See Monitor FEV1 in an individual for details on ID selection.    

 

 
 

Percent Predicted FEV1 

Percent Predicted FVC 

FEV1/FVC Ratio 
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Monitor an individual in a dual window  

1. On the Individual Evaluation menu click Dual Window to obtain a chart which 
shows both observed FEV1 evaluation and percent predicted evaluation on the same 
screen, as shown below.  

2. Click the arrow next to combo box (ID box) in the left bottom corner to select the ID.  
See Monitor FEV1 in an individual for details on ID selection.    

 

 
 



11 

Individual identity specification 

1. This option enables the user to select an individual by his name. The option will 
function only if individuals’ names (Last_Name, First_Name, Middle_Initial) are 
included in the SPIROLA database. 

2. On the Individual Evaluation menu click Individual Identity to display an 
Individual Identity window, as shown below.  

3. Type the person’s name into the Individual Identity window and click Find… 
4. Select the desired name from the list and click OK.  
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3.4 Group Evaluation Menu 
The Group Evaluation menu lists functions for evaluation of: pair-wise within-person 
variation; means for FEV1 and FVC; and the mean slope and within-person variation.  
 

   
 

Monitor longitudinal data precision in a group 

1. Double click on Within-person Variation on the Group Evaluations menu to show 
the yearly values of the pair-wise within-person variation sp (absolute) and sr 
(relative), as shown below. The annual pair-wise within-person variation sp and sr are 
calculated using FEV1 measurements repeated within 18 months. A sample of at least 
50 individuals with repeated measurements is needed to obtain a reliable estimate of 
the within-person variation. If the number of repeated measurements (the number 
shown in orange on the screen) is less than 50 in any one year, the sp and sr values for 
that year are not displayed. The legend at the bottom of the screen shows the mean sp 
and sr values for the monitoring program (Section 5).  

2. To print the figure or preview the printout click Report Print or Report Preview on 
the Report menu.  Close the report preview to proceed. 
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Monitor mean FEV1 and FVC values in a group 

1. On the Group Evaluations click Means for FEV1 (or FVC) to display yearly means 
for observed, predicted, and percent predicted values as shown below for FEV1.   

2. To print the figure or preview the printout click Report Print or Report Preview on 
the Report menu.   

 

 
 
The mean FEV1 chart shows group means for predicted (yellow), observed (green), and 
percent predicted (red) FEV1 values. Same applies for FVC chart. The predicted values 
are derived from prediction equations that take into account age, height, sex, and 
race/ethnic background, and are based on nationally representative healthy never-
smokers.7 Irregular deviations of observed mean values from predicted values may be 
due to changes in measurement procedures, or due to effects of occupational exposure or 
interventions.  Monitoring mean FEV1 and FVC values can help to identify systematic 
effects taking place at a group level. 
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3.5 Quality Control Menu  

Monitoring quality control indices 

1. Double click on Quality Control menu to show the quarterly quality indices and 
relative pair-wise within-person variation sr, as shown below. The quality indices are 
expressed as: (a) the percentage of tests that do not meet the 2005 ATS/ERS criteria 
for acceptability and repeatability (i.e., grades C, D, or F), and (ii) the percentage of 
tests that do not meet the 2005 ATS/ERS criteria for repeatability (>150 ml between 
best and second best tests). This function is available only if the quality control 
variables are included in the user’s SPIROLA database (Appendix, data format).  

2. To view charts for individual technicians, click the arrow next to the combo box (ID 
box) on the left bottom corner and select a technician’s code. 

  

  
 
The chart shows spirometry quality grades (green lines) and repeatability scores (blue 
lines) for FEV1 (circle), FVC (square) and for test session (triangle). The relative pair-
wise within-person variation is also plotted on the chart (red line). Calculation of the 
quality grades requires data for variables Q FEV1, QFVC, or QTEST, and repeatability 
scores require best and second best FEV1 and FVC values (see Appendix). 
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3.6 Report Menu 
1. To print a current chart, click Report Print on the Report menu (see below). 
2. Results in an individual report can be printed together with the FEV1 or FVC chart. 
3. To preview the report, click Report Preview on the Report menu and a printable 

report will appear. Close the report to proceed. 
 
An example of a printed report:  
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3.7 Options Menu 
SPIROLA provides options to change default values or adjust parameters; these changes 
take effect during the current SPIROLA session only.  (To save and automatically load 
the changes on the next run, see Save Options later in this chapter.)  The user may:  
• select a referential rate of decline for the calculation of LLD based on the actual data;  
• select within-person variation for the calculation of LLD based on the actual data;  
• customize data display on charts;  
• temporarily remove outliers from the individual data analysis;  
• customize reference equations used for LLN and 60% predicted FEV1 values.  
The Option menu allows implementation of some of the options.  
  

 

Referential rate of decline 

SPIROLA uses a default of 40 mL/yr for the referential rate of FEV1 decline. The 
Referential Rate of Decline option enables changing the default value. Studies indicate 
that the mean rate of FEV1 decline in healthy never-smokers is about 30 mL/yr. To 
achieve greater predictive values of the limit of longitudinal decline (LLD) for moderate 
impairment of lung function, a referential rate of decline based on all healthy individuals 
regardless of smoking status, should be used. In preliminary analyses, we determined this 
to ranges from 40 to 45 mL/yr. SPIROLA calculates the mean rate of decline for the 
group using all individuals with four or more years of follow-up and shows the result on 
the Group Evaluation menu. Using the mean rate of decline as the referential rate of 
decline together with the average within-person variation will result in identifying about 
5% of declines as excessive.5 

 
1. On the Options menu, click Referential Rate of Decline and a dialog window will 

appear, as shown below. Select a desired value from the list box, click OK. 
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Within-person standard deviation 

SPIROLA uses as the relative within-person standard deviation sr of 4% and the 
corresponding LLDr of 10% as defaults (see Section 5).  When ATS/ERS 
recommendations on quality control are followed, workplace monitoring programs can 
achieve comparable data precision. These limits are goals that can help to achieve a 
satisfactory level of data precision.  
 
However, if the relative within-person standard deviation rs , shown at the bottom of the 
Group Within-person Variation chart, is significantly higher/lower than the default 
value of 4%, SPIROLA provides an option for changing the default value to the observed 

rs value. If the rs value is greater than 6%, then the LLDr of 15%, which corresponds to 
the ACOEM limit, should be used and effort be made to improve spirometry quality. 
 
1. On the Options menu, click Within-person Variation, and then click Absolute 

Value or Relative Value, and a new dialog window will appear, as shown below. 
2. To select an existing value from the list box, click the arrow button of Within-person 

standard deviation or Longitudinal limit, and click a desired value.  If a desired 
value is not in the list box, enter the value, and click the Add button to add it.  

3. Click the OK button to confirm the selection or Cancel button to cancel the selection. 
 

Critical limit curves  

1. On the Options menu, click Display, and then click Curves.  A new dialog window 
will appear, as shown below. 

2. To enable or disable display of a critical limit curve, click the check box next to the 
name of each critical limit curve to check or uncheck that box.  By default, all curves 
are checked except the absolute LLD for FEV1 and the LLN for FVC. 

3. Click the OK button to confirm the selections and close this window, or click the 
Cancel button to cancel any current selections and close this window. 
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Show height in inches or centimeters 

1. By default, each individual’s height is shown in centimeters in the data table.  To 
display height in inches, click Display on the Options menu, and then click Show 
Height in cm to remove the “check” mark. 

 

 
 

Display charts using a white background 

1. By default, the background color for all charts in blue. To change to a white 
background, click Display on the Options menu, and then click White Background.  

 

Display values of an observation 

1. Place the cursor on any data point on the longitudinal FEV1 evaluation chart, and then 
left click. A small yellow tooltip label will popup. 

2. After a second, this tooltip label will disappear automatically. 
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Remove outliers from a longitudinal analysis 

1. On the chart, place the cursor on any data point(s) which you want to temporarily 
remove, and then right click.  The data point(s) will disappear from the chart, and the 
regression line and other curves will be recalculated and redrawn (see two charts 
below). The last data point can not be deleted. 

 
Note:  The deleted data points are not deleted from the dataset, but only from the current 
report.  When the user reloads the individual’s ID, all points will be shown again. If the 
user wishes to correct a data value, this needs to be done directly in the .mdb database. 
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Customize the reference equation for LLN and predicted values 

1. On the Options menu, click Reference Equations to display a Select Reference 
Equations window, as shown below.  By default, we use reference equations based on 
NHANES III data to calculate lower limit of normal (LLN) and predicted values.7 

 

  
 
2. To customize the LLN reference equations, select Custom Reference and a tab page 

will appear, as shown below.  
 

 
 
3. Enter custom parameters in the New Values area, and then click Save.  The new 

values will be saved and show as a row in the equation table.  
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4. Repeat step 3 until all custom parameters are shown in the table. 
5. Click OK.  All relative curves will then be redrawn based on the new custom 

reference equations. 

Save Options 

To save user selected options and automatically load these options on the next startup of 
SPIROLA on the Options menu click Save Options and the options selected by the user 
will be saved into an .xml file named app.xml stored in the C:/SPIROLA folder and 
applied on the next run.  
 

 
 

3.8 Risk List Menu 

Screen for individuals at risk for respiratory impairment  

1. On the Risk List menu, click Risk List to create a list of individuals whose rate of 
decline is excessive or whose last lung function tests (FEV1, FVC, or the FEV1/FVC 
ratio) are below LLN.  The final list is marked by orange background.  See Section 4 
for the selection criteria. 

2. Risk List processing time depends on the size of the dataset and the performance of 
the computer. SPIROLA shows processing progress as shown below.  
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3. When completed, the results are displayed on the Risk List Query window, see 

below. These results will be shown each time the user clicks on the Risk List. The 
Risk List will be permanently saved until another Update Risk List is executed.  

4. The information provided on the Risk List Query summary table enable the user to 
determine when was the risk list created or updated, and the database information. If 
the risk list is not for the current dataset or is outdated, the user needs to update the 
risk list by clicking on Update the Risk List on the Risk List Query.  

5. To print only the summary statistics click on Print Summary.   
6. To select a subset of individuals with excessive decline only or individuals whose last 

spirometry values are below the LLN only, click on Excessive Decline or Below 
LLN, respectively.  

7. To evaluate the selected group of individuals click on Evaluate button and proceed to 
select a method of analysis from the Individual Evaluation or Group Evaluation 
menus, or click on Print List to print the selected list.  

8. To identify a particular individual from the selected subset, place a pointer next to a 
desired ID and click on Current ID. 

9. To exit from the Risk List click on Exit.  
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Tag individuals for further evaluation 

The user may search through either whole data set or the risk list and tag individuals for 
further data evaluation by clicking on the Tag menu and then on a selected item, see 
below. For example, an individual whose spirometry value is below LLD can be tagged 
for Quality Control or Re-testing at the initial stage of evaluation.  
 

 
 
On completion of tagging, click Tag List (see above) to display the list (see below).  
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4. Evaluation and Interpretation of Results 

Interpretation and suggested actions  

The table below summaries “Interpretations” and “Suggested actions” provided in the 
Summary Report, according to the duration of follow-up. Individuals whose lung 
function is categorized as shown in the table are selected into Risk List (see below). 
 
Interpretation    Suggested action(s) 
Less than 8 years of follow-up    
FEV1< LLDr   
 

Examine spirometry quality and re-test.  If confirmed that 
FEV1<LLDr, consider annual testing and intervention.   

FEV1<LLN   
 

Examine spirometry quality and re-test.  If confirmed that FEV1<LLN, 
consider annual testing and intervention. 

FEV1/FVC<LLN  
 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC<LLN, the individual has airflow obstruction; consider 
annual testing and intervention. 

FEV1/FVC≥LLN and  
FVC<LLN† 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC≥LLN and FVC<LLN, the individual may have restriction; 
consider annual testing and intervention. 

FEV1/FVC≥LLN and 
FEV1<LLN and 
FVC<LLN† 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC≥LLN, FEV1<LLN, and FVC<LLN, the individual may 
have mixed obstructive and restrictive impairment; consider annual 
testing and intervention. 

FEV1<60% predicted  
 

Examine spirometry quality and re-test.  If confirmed that FEV1<60% 
predicted, the individual has substantial impairment of lung function; 
consider annual testing, intervention, and referral for clinical 
evaluation. 

Rate of FEV1 decline and within-
person variation are provided. 

Prior to 8 years of follow-up, excessive decline is evaluated using the 
LLD limit. The rate of decline is provided as additional information.  

8 or more years of follow-up  
FEV1<LLDr  (derived from the 
regression line) 

Examine spirometry quality and re-test.  If confirmed that FEV1< 
LLDr, consider annual testing.   

Rate of FEV1 decline >90 mL/yr.5 
 

Examine spirometry quality and re-test.  If confirmed that the rate of 
FEV1 decline is > 90 mL/yr, consider annual testing and intervention. 

Projected  FEV1 declines to 60% 
predicted before 70 years of age 

Examine spirometry quality and re-test.  Because the individual is at 
risk of developing moderate-severe respiratory impairment around 
[AGE] years of age, consider annual testing and intervention.   

FEV1/FVC<LLN 
 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC<LLN, the individual has airflow obstruction. 

FEV1/FVC≥LLN and 
FVC<LLN† 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC≥LLN and FVC<LLN, the individual may have restriction; 
consider annual testing and intervention. 

FEV1/FVC≥LLN and 
FEV1<LLN and 
FVC<LLN† 

Examine spirometry quality and re-test.  If confirmed that 
FEV1/FVC≥LLN, FEV1<LLN, and FVC<LLN, the individual may 
have mixed obstructive and restrictive impairment; consider annual 
testing and intervention. 

FEV1<60% predicted  
 

Examine spirometry quality and re-test.  If confirmed that FEV1<60% 
predicted, the individual has substantial impairment of lung function; 
consider annual testing, intervention, and referral for clinical 
investigation. 

† For FVC, SPIROLA uses 70% predicted criteria when NHANES3 reference values are used.   



25 

 

Risk List evaluation procedure 

The Risk List identifies individuals who fulfill any of the criteria listed in the above 
table. In evaluating an individual identified to be at risk of impairment the following 
procedure should be considered. 
 
1. Examination of the individual’s existing data 
(i) Examine the longitudinal demographic, FVC, and FEV1 data shown in the table 

below the FEV1 chart, to make sure that the data are reasonable.  
(ii) If a data point appears to be an outlier, temporarily exclude the point by right 

clicking on it and then evaluate the new results on the chart and in the report. 
(iii) If a single data point appears to be an outlier and causes the individual’s selection 

into the risk list, check for possible data errors. The first (baseline) observation 
may sometimes be lower due to the learning effect. When this happens, exclusion 
of the baseline value may improve precision of the interpretation. 

(iv) If a data error is found, correct the data in the .mdb database using Microsoft 
Access software, re-run SPIROLA, and review the new Summary Report.   

2. Examination of the individual’s spirometry data quality 
(i) If quality grades are provided in the SPIROLA data, examine these and the 

technician report for the percentages of test meeting the ERS/ATS criteria. 
(ii) Examine the original spirometry tracings using the ATS standardization criteria 

of: (a) acceptability (extrapolated volume, cough in first second, end of test 
criteria, obstructed mouthpiece, extra breath, cessation of airflow); and (b) 
repeatability (≤ 150 mL).9    

(iii) If an acceptability error is found, consider removing data for that test from the 
dataset, correct the SPIROLA .mdb file using Microsoft Access, and then re-run 
SPIROLA to produce a new Summary Report for the individual.     

(iv) Provide feedback to the spirometry technician(s) on the spirometry errors found.  
3. Re-test the individual 
After the first two steps have been completed and SPIROLA still identifies the person as 
being at risk, consider re-testing the person within six months from the most recent test.  
If the re-tested spirometry values confirm the original interpretation, consider the 
suggested actions in the new Summary Report.   

Suggested intervention measures 

When spirometry quality issues are satisfied and re-testing confirms that a person has 
impairment or is at increased risk of developing respiratory disease, implementation of 
annual testing and intervention measures should be considered.  The severity of existing 
impairment and the projected age at which substantial impairment is likely to occur 
should be considered when deciding on the type of intervention(s).  
 
Interventions on an individual level:  
Discussing lung function results with a worker can motivate the individual and can help 
to determine what course of action is acceptable to the individual to prevent further 
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excessive lung function loss.  Decreasing inhalation of noxious particulates and gases is 
usually the most important intervention.  The most important risk factor for excessive 
decline in lung function in smokers is often tobacco smoking, for which nicotine 
replacement therapy may provide best results for smoking cessation.10 Complete smoking 
cessation may be needed to halt excessive lung function decline.11 Occupational 
exposures to respiratory hazards also represent an important risk.12  Evaluation of 
individual occupational exposures should be done.  Where possible, hazardous exposures 
should be reduced or eliminated through engineering controls (e.g., substitution of less 
hazardous materials, process enclosure, workplace ventilation).  Administrative controls 
(e.g., revised work practices) may also help limit hazardous occupational exposures.  
Finally, use of effective personal protective equipment (e.g., respirators) should be 
recommended when other measures are infeasible or insufficient by themselves.  The 
potential synergistic effect of smoking and occupational exposure on increased risk of 
excessive decline in lung function should be explained to individuals who smoke and are 
exposed to occupational respiratory hazards. Weight gain can also contribute to lung 
function decline due to loss of fitness and difficulty in performing the spirometry test at 
full lung capacity. Body mass index (BMI) greater than 25 kg/m2 can be associated with 
lower lung function when other factors such as gender, height, race, smoking, and 
respiratory symptoms, are controlled for. Increasing change in BMI/year can be also 
associated with an additional FEV1 decline. 
 
Interventions at a company level:  
Management commitment to an integrated worksite health and safety program provides a 
key foundation for success in maintaining a healthy workforce.  Programs are likely to be 
more effective when they are based on management’s understanding of workers’ 
concerns about health risks on the job.  By identifying workers’ priorities, smoking (for 
example) can be addressed in the broader context of worksite safety.  Intervention at the 
individual level is then more likely to be successful.  
 
Evaluation of the effect of intervention(s):  
To determine the effect of individual intervention on the rate of FEV1 decline using 
SPIROLA, use the small rate of decline chart on the individual FEV1 evaluation.  To 
determine the effect of an integrated worksite health and safety program using SPIROLA, 
assess trends on the FEV1 and FVC means for the whole group and for the at-risk 
subgroup.  An expansion of this feature is planned for a future version of SPIROLA. 
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5. Theoretical Background  
 
The use of SPIROLA may help preserve lung function by:  
(i) evaluating longitudinal data precision and quality control indices,13 and promptly 

identifying when intervention on spirometry quality is warranted to maintain data 
precision at an acceptable level;  

(ii) identifying individuals with excessive decline in lung function using limits of 
longitudinal decline (LLD) based on the program’s actual data precision, or if 
data precision can not be determined, based on the default criteria (i.e., sr=4% or 
LLDr=10%) or the ACOEM longitudinal limit criteria (i.e., sr=6% or 
LLDr=15%);  

(iii) identifying individuals who already have lung function impairment using 
ATS/ERS criteria based on cross-sectional data evaluation; 

(iv) identifying when an individual’s lung function warrants individualized 
intervention measures; 

(v) evaluating the effects of intervention at the individual level and the group level. 
  

Evaluation of FEV1 precision in a group 

Monitoring a program’s data precision on an annual basis can help to identify and address 
data quality problems soon after these occur and this way achieve and maintain high data 
precision.  To monitor data precision, SPIROLA calculates and charts yearly values of 
the absolute within-person standard deviation sp and the relative within-person standard 
deviation sr.4-6  These statistics are calculated on a yearly basis as the difference between 
FEV11i  and FEV12i  measured within 18 months of each other and summed over i = 
1,..,n  individuals. The year of the first measurement determines the assigned year.  A 
sample of at least 50 individuals with repeated measurements is needed to obtain a 
reliable estimate of yearly FEV1 variation.   
 
The absolute within-person standard deviation sp for a specific year is defined as:  
 
 
 
 
The relative within person standard deviation rs  adjusts for each individual’s FEV1 size 
and for a specific year is defined as:  
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The average values ∑= )(s)/1( pip inkNs and ∑= )(s)/1( rir inkNs  are calculated by 
summing the yearly weighted ps  and rs values over all years of follow-up and then 
dividing by the total number of repeated observations N.  These values represent the 
average program-specific absolute and relative pair-wise within-person variation, 
respectively. The ps and rs values are shown at the bottom of SPIROLA’s Group Within-
person Variation chart as ‘Mean ps ’ and ‘Mean rs ’.  The mean within-person standard 
deviations ps  and rs  can be used also to derive the program-specific limits of 
longitudinal decline (LLD) by substituting these for the default values on the Options 
menu under Within-person Variation option.  
 
Note:  If the sample of measurements repeated within 18 months is less than 50, the sp 
and sr values are considered unreliable and are not displayed. If ps and rs values are not 
displayed or are based on a sparse sample, the user could use the default LLDr value of 
10% or change the default to LLDr of 15% as based on the ACOEM limit. Alternatively, 
the user can use the group mean within-person variation, shown as RMSE on the Group 
Evaluation menu or as Group sw under each FEV1 chart, estimated as the mean of 
individuals’ within person variations estimated by the linear regression analyses. The 
validity of this estimate will depend on the number of individuals who have four or more 
longitudinal measurements.     
 
 
Estimation of limits of longitudinal decline for an individual 
 
Because of inherent FEV1 variability, it takes approximately 5-8 years of follow-up to 
obtain a reliable estimate of the rate of FEV1 decline in an individual.4-6  To identify 
individuals with an excessive FEV1 decline within the first 8 years of follow-up, 
SPIROLA uses by default the relative limit of longitudinal decline (LLDr),6 but the 
absolute limit (LLDa) or the ACOEM limit based on 15% can also be displayed.  The 
LLDr  limit is applied to determine whether the lung function decline between the 
baseline FEV1 value (or a mean of the first two observations, if the first FEV1 value is 
lower than the second one) and each follow-up FEV1 value is excessive.  Observations 
that fall below the LLD warrant concern. The absolute or relative longitudinal limits are 
calculated based on the average within-person FEV1 variability for the group or using the 
default values.   
 
The absolute limit of longitudinal decline LLDa (mL/yr) is defined as a one-sided 95% 
confidence limit: 

 LLDa = t × (b +1.645×SE(b)) 

where t is the duration of follow-up in years and b is either the referent slope of decline 
(up to 8 years of follow-up) or the individual’s estimated regression slope (beginning 
with 8 years of follow-up).  SPIROLA uses a default referent slope of decline of 40 
mL/yr based on an analysis evaluating performance characteristics of the limit with 



29 

respect to sensitivity and specificity for long-term excessive decline in FEV1of >90 
mL/yr and FEV1 <60% predicted.  The standard error of the slope b is defined as   

 )1(/)1(12)(SE +−= PPtPb wσ                   (1) 

where t is the duration of follow-up in years, P=2 represents two repeated measurements 
done during the follow-up time t (the baseline and last observation), and wσ  is the 
within-person standard deviation.  By substituting the program-specific pair-wise 
estimate of the within-person standard deviation ps for the within-person variation wσ  in 
equation (1), one can estimate program-specific absolute LLDa. 
  
The relative limit of longitudinal decline LLDr (%) standardizes for the magnitude of 
FEV1 and is defined as:  

 LLDr  = t × (b/ b1

______
FEV +1.645×SEr(b))      (2) 

where b1

______
FEV  is the program-specific mean baseline FEV1, and SEr(b) is the approximate 

standard error of  b/ b1

______
FEV  calculated by substituting the program-specific relative 

within-person standard deviation rs  for wσ  in equation (1). 
 
The limit for the actual value of FEV1 (mL) below which an individual’s FEV1 should 
not decline after t years of follow-up without raising concern can be calculated in terms 
of the individual’s baseline FEV1b value and LLDa or LLDr, as follows:     

 FEV1 = FEV1b - LLDa 

 or    

 FEV1 = FEV1b - FEV1b ×LLDr    

SPIROLA’s default value for the relative within-person variation rs is 4%, which 
corresponds to LLDr of 10% for t=1 (i.e., annual follow-up). The LLDr of 15% for t=1, 
which corresponds to the ACOEM limit, is based on rs of 6%. To change this default 
value, on the Options menu use the Within-person Variation option. Beginning with 8 
years of follow-up, the interpretation of excessive decline is based on an individual’s 
regression slope and the lower 95% confidence limit around the regression line calculated 
as above. Here b represents the estimated regression slope and the individual’s baseline 
measurement FEV1b is replaced by the individual’s predicted FEV1 value.  

Cross-sectional evaluation to identify respiratory impairment 

SPIROLA evaluates and reports for the most recent spirometry test whether the FEV1, 
FVC, or FEV1/FVC ratio values are below the respective “cross-sectional” lower limit of 
normal (LLN) values or whether the FEV1 value is below 60% predicted.  By default, the 
LLN values and the predicted values are calculated using the Hankinson et al. reference 
equations estimated separately for Caucasians, African-Americans, and Mexican-
Americans on US population data.7 In addition, user-defined reference equations for 
FEV1, FVC, and the FEV1/FVC ratio can be specified. For FVC SPIROLA uses 70% 
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predicted value for decision making, when NHANES7 based reference values are used, 
but LLN for user-specified reference values. The Options > Display >Curves menu 
enables users to select for display either LLN or 70% predicted or both.   
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Appendix  

Data source and format 

SPIROLA requires demographic and spirometry data stored in or transported to a 
Microsoft Access database as a data table. The table needs to be sorted by ID and 
TestDate. Each record contains information on a single spirometry test with the following 
fields and a specified type. Fields can be in any order and variable names are not case 
sensitive.  
 
The following variables are essential (must be included) for the SPIROLA analysis: 
  
• ID – A text field (alpha numerical) to identify a tested individual 
• Sex – A text field to store “M” for male or “F” for female gender 
• Race – A text field to store “M” for Mexican-Americans, “B” for African-Americans, 

or “W” for Caucasians and other groups.  This variable is used for selecting the 
appropriate set of reference equations. 

• Age – A numerical field for age in years at a test (optional if date of birth provided) 
• BirthDate – A date field (format: mm/dd/yyyy) to store date of birth (optional, allow 

more accurate calculation of age, eg. 45.5 vs. 45)   
• Height – A numerical field to store height (cm) measurements of a tested individual  
• FEV1 – A numerical field to store best FEV1 (mL) value of a tested individual 
• FVC – A numerical field to store best FVC (mL) value of a tested individual 
• TestDate – A date field (format: mm/dd/yyyy) to store test dates 
 
The following variables are optional for spirometry quality analysis: 
 
• FEV12 – A numerical field to store second best FEV1 (mL) value  
•  FVC12 – A numerical field to store second best FVC (mL) value  
• QFEV1 – A character variable for FEV1 quality grades (if available) 
• QFVC – A character variable for FVC quality grades (if available) 
• QTest – A character variable for session quality grades (if available) 
• Oper – A character variable for operator (spirometer technician) code or name   
• Provider – A character variable for a provider (e.g., a van service) 
 
The following name variables are optional and are need for a search by name:  
 
•        Last_Name – A text field (Surname/family name) 
•        Middle_Initial – A text field (leave blank if not available) 
•        First_Name – A text field 
 
Inclusion of names in the database enables the user to identify an individual by name 
using ‘Individual Identity’ function in the ‘Evaluation menu’. To use ‘Identity Function’ 
all three name variables must be provided. 
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Additional fields containing, for example, weight, smoking status, cigarettes/day, asthma 
status, quality control code, technician code, or respiratory symptoms data can be added. 
These data will be shown at the bottom of individual’s FEV1 chart, but will not be used in 
the analysis. 
 
Importing data into SPIROLA 
 
Data stored in other standard databases can be imported into a Microsoft Access database 
using the “Import” facility.  To create the required variable format (e.g., “M” for male), 
the original variables can be converted by designing a Make-Table Query object in 
Access or by Macro programming.  To avoid data loss, all .mdb files should be backed 
up in C:\SPIROLADATA. 
ATS/ERS guidelines on Standardization of Lung Spirometry, recommend a standard 
format for databases generated by spirometers (Eur Respir J 2005; 26:319-338). All the 
variables specified by SPIROLA are defined by the ATS/ERS guidelines to be included 
in the standard database. At this stage the user needs to convert the spirometer-generated 
database into an Access database. Future SPIROLA revisions will enable automatic 
access to the ATS/ERS standardized data files.   

Incorrect records or missing values  

If a record has missing or incorrect values for variables such as ID, Age or BirthDate 
(one needs to be present), Height, FEV1, FVC, or TestDate,  the record is excluded from 
the analysis, but it is stored in a data file DeletedRecords.xml on the folder C:\Spirola. 

Software requirements to run SPIROLA 

• Microsoft Windows XP or Windows 2000/2003 
• Microsoft .NET Framework and Database engine. In most cases these software 

packages are already installed in the user’s computer.    
• Microsoft Access is optional and enables viewing or editing data in Microsoft Access 

format. 
 
SPIROLA installation package downloaded from webpage or from CD. Some support 
programs are required to run SPIROLA.  In most cases, these programs are already 
installed with Microsoft Windows XP. SPIROLA may alert the user to install the .NET 
Framework or other components from Microsoft web sites.  
 Microsoft .NET Framework version 1.1 redistributable package.  This package 

includes everything needed to run applications developed using the .NET Framework.  
To install this framework, run program DOTNETFX.EXE provided in the SPIROLA 
software package or obtained as a free download from following link: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-
8157-034d1e7cf3a3&displaylang=en 

http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-8157-034d1e7cf3a3&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-8157-034d1e7cf3a3&displaylang=en
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 Microsoft Data Access Components (MDAC).  This is for applications that use data 
access.  To install this framework, run program MDAC_TYP.EXE provided in the 
SPIROLA software package or obtained as a free download from following link: 
http://www.microsoft.com/downloads/details.aspx?familyid=78cac895-efc2-4f8e-
a9e0-3a1afbd5922e&displaylang=en 

http://www.microsoft.com/downloads/details.aspx?familyid=78cac895-efc2-4f8e-a9e0-3a1afbd5922e&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=78cac895-efc2-4f8e-a9e0-3a1afbd5922e&displaylang=en
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